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Firmware versions

The Type 5757-3 Electric Actuator with Process Controller is available in various firmware
versions. The firmware version is written on the nameplate of the device.

Firmware version Additional features

2.0x • Switching output
• Data logging function
• Command mode (stem retracts/extends)

2.1x

The Mounting and Operating Instructions are valid for all firmware versions. Differences in
operation are described in these instructions.
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DANGER!
indicates a hazardous situation which, if not
avoided, will result in death or serious injury.

WARNING!
indicates a hazardous situation which, if not
avoided, could result in death or serious inju-
ry.

NOTICE
indicates a property damage message.

Note: Supplementary explanations,
information and tips

Definitions of the signal words used in these instructions
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General safety instructions

1 General safety instructions

For your own safety, follow these instructions concerning the mounting, start up and operati-
on of the electric actuator with process controller:

� Mounting, start-up and operation of this device may only be performed by trained and
experienced personnel familiar with the product.
According to these Mounting and Operating Instructions, trained personnel refers to
individuals who are able to judge the work they are assigned to and recognize possible
hazards due to their specialized training, their knowledge and experience as well as their
knowledge of the applicable standards.

� Any hazards which could be caused in the connected valve by the process medium,
operating pressure or moving parts are to be prevented by means of the appropriate
measures.

� The actuators has been designed for use in electrical power installations.
For wiring and maintenance, you are required to observe the relevant safety regulations.
The actuator must be protected against unintentional reconnection of the power supply.

� Before wiring the electric actuator, disconnect it from the power supply.

To avoid damage to any equipment, the following also applies:

� Proper transportation and storage are assumed.



2 Design and principle of
operation

The Type 5757-3 Electric Actuator with Pro-
cess Controller is an electric actuator with an
integrated digital controller. It can be moun-
ted onto SAMSON Type 3222,
Type 3222 N, Type 2488 and Type 3267
Valves (DN 15 to 25) and onto special ver-
sions of Type 3260 and Type 3226 Valves.

The electric actuator with process controller
has an input for a Pt 1000 temperature sen-
sor. It can function as a fixed set point con-
troller with this input.
Alternatively, the electric actuator can be
used for domestic hot water in instantaneous
heating system. In this case, either a flow
rate sensor or a flow switch must be used.
The flow switch recognizes when the hot wa-
ter is being tapped. The flow rate sensor can
additionally record the quantity of hot water
being tapped. An optimization function
adapts the control to the changing network
conditions.
In addition to the temperature sensor input,
the electric actuator has a current input. This
can be used in place of the temperature sen-
sor or to connect an external set point. In ac-
tuators with switching output (firmware ver-
sion 2.0x/2.1x) the switching output can be
configured as a pump output (circulation
pump for DHW circuit or heating circuit), a
fault alarm output or an indication output for
the tapping function.

The set point of the digital controller is set to
60 °C and can be changed in
TROVIS-VIEW using a connecting cable
connected to the RS-232 interface (serial in-
terface) on the actuator or using a memory
pen.

The controlled variable, control behavior
and operating direction of the actuator can
also be changed in TROVIS-VIEW.

The output signal of the process controller is
issued as a three-point stepping signal to the
synchronous motor of the actuator and is
transferred over the connected gear to the
actuator stem (3) to stroke the valve. The
motor is switched off by torque-dependent
switches when an end position is reached or
in case the motor is overloaded

The actuator is mounted onto the valve using
a coupling nut (4).
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Fig. 2 · Functional diagram

Stem retracts

Stem extends

1 Electric actuator
1.1 Connecting lead
2 Handwheel
3 Actuator stem

4 Coupling nut
5 Travel indicator
6 Plug stem
7 Valve spring
8 Cover, serial

RJ-12 jack



When the actuator stem extends, the globe
valve is closed, opposing the force of the
valve spring (7, Fig. 2). When the actuator
stem retracts, the valve is opened as the plug
stem (6) follows the motion of the return
spring
When connected to a three-way mixing
valve, the extending actuator stem causes
the valve (A � AB) to open.

The valve can be moved to any position
when the power supply is disconnected by
the handwheel (2, Fig. 2).
Travel and direction of action can be read
off the travel indicator (5) at the side.

2.1 Accessories

Accessories for communication:
TROVIS-VIEW Software (6661-1062) is re-
quired, see section 7.

Accessories for domestic hot water in
instantaneous heating systems:

Type 5207-0060 Temperature Sensor
Fast-responding Pt 1000 sensor, see Fig. 7,
page 16/17.
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Fig. 3 · Typical application for domestic hot water with Pt 1000 sensor and flow rate sensor

Hot water
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2

3
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1 Heat exchanger
2 Temperature sensor including sensor pocket, VSTW

3 District heating supply (VL)
4 Type 5757-3 Electric Actuator with Process Controller
5 Flow rate sensor with cable
6 District heating return flow (RL)
7 Valve, e.g. Type 3222

Cold water

Circulation



Sensor pocket
To provide the best positioning of the
Pt 1000 sensor at the heat exchanger, see
Fig. 7, page 16/17.
Order no. 1400-9249

2.2 Technical data

Flow rate sensor with extension cable
Axial turbine flowmeter, see Fig. 7,
page 16/17.
Order no. 1400-9246
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Type 5757-3 Electric Actuator with Process Controller

Rated travel 6 mm

Transit time for rated travel 20 s

Nominal thrust 300 N

Supply voltage 230 V (±10 %) / 50 Hz

Power consumption Approx. 3 VA

Class of protection II according to EN 61140

Perm. ambient temperature 0 to 50 °C

Perm. storage temperature –20 to 70 °C

Degree of protection IP 42 according to EN 60529

Mounting position Any, but not suspended

Electromagnetic compatibility According to EN 61000-6-2, EN 61000-6-3 and EN 61326

Weight Approx. 0.7 kg

Binary input BE11) Set point switchover

Binary input BE21) Flow switch

Version with switching output (firmware version 2.0x/2.1x)

Switching output 230 V, 50 Hz, max. 1 A

Additional electrical equipment

Temperature sensor Pt 1000: –50 to 150 °C

Flow rate sensor 530 pulse/l

Flow switch Floating contact

Control input 0/4 to 20 mA
1) Recommended: Use devices with gold contacts when using relays



2.3 LED blinking pattern

The actuator has a red and a yellow LED which indicate the operating state of the actuator.
The LEDs are located underneath the cover on top of the actuator.

Blinking pattern of the yellow LED

• Device switched off or no communication with memory pen or command pen inserted

• Device switched on or memory pen inserted: Memory pen action completed
(see section 8.2.2)

• Memory pen inserted: Preparing to read from memory pen (see section 8.2.2)

• Memory pen inserted: Preparing to write data to memory pen (see section 8.2.2)

• Memory pen inserted: Validity error in memory pen
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• Memory pen inserted: EEPROM error in memory pen

Blinking pattern of the red LED

• Normal operation or memory pen inserted

• Device is starting up after a reset has been performed or limit switch error

• Temperature too high (upper limit value GWH exceeded)

• EEPROM error in device
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• Zero calibration in progress

• Transit time measurement in progress

• Wire breakage at temperature input

• Wire breakage at current input

• Flow rate at flow rate sensor exceeds measuring range
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3 Connection to the valve

The actuator has a force-locking connection
to the valve when the power supply is dis-
connected.

� Turn the handwheel (2, Fig. 2) counter-
clockwise to retract the actuator stem as
far as it will go.

� Place the actuator on the valve connec-
tion and screw coupling nut (4, Fig. 2)
tight (tightening torque 20 Nm).

3.1 Mounting position

Any mounting position may be used, howe-
ver, the actuator may not be installed in a
suspended position.
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4 Electrical connection

Risk of electric shock!
When installing electric cables, you
are required to observe the regula-
tions governing electrical power
plant installation according to
DIN VDE 0100 as well as the regu-
lations of your local power supply
company.
Use a suitable power supply which
guarantees that no dangerous volta-
ges reach the device in standard
operation or in the event of a fault in
the system or in any other system
parts.

Connect the actuator to the electrical
network only after the power supply
is first switched off. Make sure the
power cannot be switched on unin-
tentionally!

For the actuator to function, a Pt 1000 tem-
perature sensor must be connected.

The binary input can be used to change bet-
ween the two set points W1 and W2.

Alternatively, instead of the Pt 1000 sensor,
the current input 0/4 to 20 mA can be used
for control purposes.

In addition, a flow rate sensor or a flow
switch can be connected to quickly recogni-
ze when domestic hot water is being tap-
ped.

Connect the ends of both connecting leads
as shown in Fig. 4 and Fig. 5 (page 13 on-
wards).

Insulate any wires that are not used.

Note:
The initialization process starts immediately
after the actuator has been connected to the
electrical power supply.
The actuator stem extends (when the directi-
on of action increasing/increasing has been
set) and the red and yellow LEDs on top of
the actuator light up.
The red LED goes out as soon as the actua-
tor stem has reached the end position.
The yellow LED continues to light up and in-
dicates that the electric actuator is ready for
operation.

Error indication:
A wire breakage at the temperature input or
at the current input is indicated by a slowly
blinking red LED. Refer to section 2.3.

Note: A faulty sensor line cannot be detec-
ted when a 0 to 20 mA input signal is used.
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Electrical connection

Fig. 4 · Wiring diagram (part 1) Note: Terminals at the point of installation, not included in scope of delivery

OG YE RD BN BK GN

230V,50Hz

+5V GNDPt Pt
GND In2In1 L N L´

BN BU BK

Operation with Pt 1000 sensor
(switching output L´as pump output)

BE1

+5V GNDPt Pt
GND In2In1

OG YE RD BN BK GN BN BU BK

230V,50Hz

L N L´

Operation with Pt 1000 sensor and
binary contact to determine the set point
(switching output L´as pump output)

BE22)

+5V GNDPt Pt
GND In2In1

OG YE RD BN BK GN BN BU BK

230V,50Hz

L N L´

Operation with Pt 1000 sensor and
flow switch
(switching output L´as pump output)

WARNING!
Live wire

1) Flow rate sensor (WSS)
2) Flow switch

Note:
The gray shaded terminal L´ only exists in
the version with switching output (firmware
version 2.0x/2.1x).

OG orange
YE yellow
RD red
BN brown
BU blue
GN green
BK black
WH white

WARNING!
Live wire

WARNING!
Live wire
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Fig. 5 · Wiring diagram (part 2) Note: Terminals at the point of installation, not included in scope of delivery

+ 0(4)...20mA –

+5V GNDPt Pt
GND In2In1

OG YE RD BN BK GN BN BU BK

230V,50Hz

L N L´

Operation with Pt 1000 sensor and
external set point over current signal
(switching output L´ as pump output)

1)

+5V GNDPt Pt
GND In2In1

OG YE RD BN BK GN BN BU BK

230V,50Hz

L N L´

Operation with Pt 1000 sensor and
flow rate sensor
(switching output L´as pump output)
Refer to Fig. 6 for details on wiring of flow rate sensor

+ 0(4)...20mA –

+5V GNDPt Pt
GND In2In1

OG YE RD BN BK GN BN BU BK

230V,50Hz

L N L´

Operation with current signal (actual value)
(switching output L´as pump output)

WARNING!
Live wire

WARNING!
Live wire

WARNING!
Live wire

1) Flow rate sensor (WSS)
2) Flow switch

Note:
The gray shaded terminal L´ only exists in
the version with switching output (firmware
version 2.0x/2.1x).

OG orange
YE yellow
RD red
BN brown
BU blue
GN green
BK black
WH white
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18.9

20

150

BK Jack

GN

WH

Nameplate Cable tie

Plug connector

Wire end ferrule

BN

GN WH

BN
GN
WH

50 mm

PVC 3 x 0.5 mm²

approx.Ø125

Fig. 6 · Wiring of flow rate sensor (WSS)

Wiring of flow rate sensor (WSS)

WSS Extension cable Type 5757-3

GND BK ––
Signal GN ––
5 V WH ––

––––––– BN ––––––––
–––––– GN ––––––––
–––––– WH ––––––––

–– BK GND
–– GN Signal
–– BN 5 V



5 Dimensions in mm
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Dimensions in mm
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Fig. 7 · Accessories

eL Stem retracts

aL Stem extends
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13 13

Flow rate sensor with
extension cable

(order no. 1400-9246)
Measuring range: 1 to 30 l/min,

DN 10, PN 10, IP 54
max. medium temperature: 70 °C

Extension cable length: 2 m

G¼

G1

35

G¾

65

Sensor pocket (incl. gasket)
for heat exchanger with G 1

(order no. 1400-9252)

39

G1

G¾

Connecting piece (incl. gasket)
for valve G 1

(order no. 1400-9237)
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Dimensions in mm

G¼

G¾

35

G¾

65

Circulation circuit
connection (incl. gasket)
(order no. 1400-9232)

Ø3.3

Ø5.4
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.5

15
52

 ±
1

20
00

ap
pr

ox
.

50

Type 5207-0060 Pt 1000 Sensor
Response times: t0.5 < 1 s,
t0.9 < 3 s; in water 0.4 m/s

PN 16
max. medium temperature: 90 °C

G¼

G¾

35

G¾

65

Sensor pocket (incl. gasket)
for heat exchanger with G ¾

(order no. 1400-9249)

38

G¾

G¾

Connecting piece (incl. gasket)
for valve G ¾

(order no. 1400-9236)



6 Function description – List of function blocks in TROVIS-VIEW

The functions listed in the Configuration folder are explained in detail in the following table.

F = Function block WE = Default setting

F Function WE Description

01 DHW tapping
recognition 1

0 – Continuous control
The actuator functions following the sensor signal

1 – Flow sensor active
Actuator is activated when DHW tapping is recognized and
finishes control when tapping is ended
(Exception: Maintaining exchanger at constant heat is active)

The fast recognition of DHW tapping is essential for domestic hot water in instantaneous heat-
ing systems since the device then immediately receives information as soon as hot water is
tapped and when tapping is finished.
As an option to the standard equipment, the device can be combined with a flow switch or a
flow rate sensor:

The flow switch records the tapping and passes on this information as a binary signal to the
device.
The flow rate sensor records the amount of hot water being tapped and issues the momentary
flow rate to the device.

02 Flow sensor 1

Only active when F 01 – 1

0 – Flow switch

1 – Flow rate sensor

03 Adaptation 1

Only active when F 01 – 1

0 – Passive

1 – Active (only when F 01 – 1 and F 02 – 1)

NOTICE:
The Adaptation function does not have any effect on the control parameter settings!
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F Function WE Description

04 Operating direction 0
0 – Increasing/increasing

1 – Increasing/decreasing

Increasing/increasing: When actual value is lower than the set point: Actuator stem retracts
Increasing/increasing: When actual value is higher than the set point: Actuator stem extends

Increasing/decreasing: When actual value is lower than the set point: Actuator stem extends
Increasing/decreasing: When actual value is higher than the set point: Actuator stem retracts

Actuator stem retracting:
Globe valve opens
Three-way valve closes port A � AB and opens port B � AB

Actuator stem extending:
Globe valve closes
Three-way valve opens port A � AB and closes port B � AB

05 Current input 0

0 – Passive (binary input)
Switchover between internal set points W1 and W2 by
activating the binary input

1 – Active: Current input active

06 Function of current
input 0

Only active when F 05 – 1

0 – Actual value
Input variable is the measured value, Pt 1000 input inactive!

1 – Set point:
Input variable is the external set point,
Pt 1000 input is the controlled variable

• Actual value: The measured input signal (mA) is in relation to the measuring range. The
Pt 1000 input is not active.

• External set point: This is compared with the temperature measured by the Pt 1000 sensor
and the deviation used for the control. Both set point and Pt 1000 signal are in relation to
the measuring range.

07 Measuring range of
current input 0

Only active when F 05 – 1

0 – 0 to 20 mA

1 – 4 to 20 mA
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F Function WE Description

08 Function of
binary input 0

Only active when F 05 – 0

0 – End maintain temperature constant in heat exchanger
When the binary input is active, maintain temperature constant
OFF

1 – Switchover between internal set points

Binary input open: W1 is the set point

Binary input closed: W2 is the set point

Depending on the configuration, the binary input is used to switchover between the two
internal set points or to end maintaining temperature constant in the heat exchanger.
The internal set points can be used, for example, for DHW heating and also for thermal
disinfection.

09
Maintaining
exchanger at
constant heat

0
0 – Time adjustable (only active when F 01 – 1)

1 – Continuous

If the device is equipped with a tapping recognition, the heat exchanger can be kept at a con-
stant temperature by this setting. This means that the heat exchanger is maintained to a de-
fined reduced temperature compared to the set point W1 over an adjustable period of time
since the last time water was tapped.

NOTICE:
An active constant temperature maintaining feature is ended upon failure of the power supply.
After reconnecting the power supply, hot water must be tapped to reactivate the constant tem-
perature maintaining feature.

10 Upper limit value
GWH 0

0 – No limitation

1 – Y is set to 0 % when GWH is exceeded

Excessive temperature protection: When the temperature exceeds GWH limit, the valve is
closed until the temperature falls below GWH limit minus hysteresis.

11 Lower limit value
GWL 0

0 – No frost protection

1 – Frost protection starts when temperature falls below GWL

Frost protection: When the temperature falls below GWL limit, the valve is controlled to move
in the opening direction until the temperature exceeds GWH limit plus hysteresis.
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F Function WE Description

Version with switching output

Firmware version 2.0x

13 Function of switch-
ing output 0

Only active when F 15 – 1

0 – Pump control

1 – Fault indication

14 Pump control 0

Only active when F 13 – 0 and F 15 – 1

0 – Circulation pump (DHW circuit)

1 – Circulation pump (heating circuit)

15 Switching output 0
0 – Passive

1 – Active

The switching output can only be used when it is active (F15 – 1). Otherwise, the settings of
function block F13 and F14 are ineffective.

WARNING!
The additional wire of the supply line (BK) may be live when the switching output is active.

Firmware version 2.1x

16 Function of
switching output 1

1 – Passive

2 – Fault indication

3 – Circulation pump (DHW circuit)

4 – Circulation pump (heating circuit)

5 – Tapping

• Fault indication: Immediately after a fault arises (e.g. wire breakage in the sensor cable or
violation of the temperature range), the switching output becomes active.

• Circulation pump (DHW circuit): The switching output is either constantly active or active for
the adjustable period of time.

• Circulation pump (heating circuit): The switching output is active while the actuator stem is
not in the end position for “stem extended”.

• Tapping: The switching output is active while hot water is being tapped.

WARNING!
The additional wire of the supply line (BK) may be live when the switching output is active.
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7 Setting and operation with TROVIS-VIEW

7.1 General

The TROVIS-VIEW Software allows various smart SAMSON devices to be configured over a
common user interface. It consists of the user interface, communication server and the de-
vice-specific module. The software has a Windows® Explorer look and feel.
The entire configuration of the electric actuator with process controller can be performed us-
ing the TROVIS-VIEW Software.
TROVIS-VIEW is available on the SAMSON website (Services > Software > TROVIS-VIEW).

Note: The following instructions include a description of the key functions of TROVIS-VIEW in
conjunction with the device. Refer to the online help in the ? menu for a detailed description.

7.1.1 System requirements

Hardware

� PC with Pentium processor or equivalent processor (300 MHz or higher), 500 MHz rec-
ommended

� Serial interface or USB/RS-232 adapter
� Min. 96 MB RAM, more than 192 MB RAM recommended
� Min. 150 MB free hard disk space plus approx. 15 to 30 MB additional hard disk space

per SAMSON module

Software

� Operating system: Windows® 2000 SP2, Windows® XP, Windows® Vista,
Windows® 7

� Microsoft® .NET Framework Version 2.0 or higher (included on installation CD-ROM)
� Internet browser: Microsoft® Internet Explorer 6.0 or higher
� PDF reader
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7.2 Installing TROVIS-VIEW

1. Run setup.exe to start installation.

Note on installation using the downloaded file:
Unzip the downloaded file before starting installation.

Note on installation using the installation CD-ROM:
Depending on the settings of your operating system, installation is started automatically when
the CD-ROM is inserted, i.e. the setup.exe file does not need to be started manually.

2. Follow the on-screen prompts and instructions of the installation program.
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7.3 Starting TROVIS-VIEW and performing settings

You can perform the settings in TROVIS-VIEW either when the device is connected (online) to
the computer or not connected (offline). Refer to section 8.

Note: When the device is not connected, the default settings appear on the user interface or,
alternatively, a saved TROVIS-VIEW file (*.tro) can be loaded and overwritten by selecting
Open in the File menu.

1. Start TROVIS-VIEW.
The user interface appears on screen.

You can read key information on this screen:

Online/offline mode: The icon on the onlinebar is animated in online mode (see
section 8.1.2).

Operating status: The current operating status is indicated on the right-hand side of the
infobar (see section 7.4).

User level: The active user level (customer or specialist) is indicated on the status bar (see
section 7.5).
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2. In View menu, select required settings for the user
interface.
All options are checked in the default setting of this
menu.
Uncheck individual options as required.

3. In Options menu, select Language to change the
interface language.
Note: Grayed languages are not available and
cannot be selected.
You can select a different language at any time.
TROVIS-VIEW switches directly to the selected lan-
guage.

4. If required, create the TROVIS-VIEW file name in
Options menu from the type, date and selectable
parameters. The created file name can be pre-
viewed before saving it (e.g. VIEW3_
5757_2009-Jun-09.tro).

5. If required, select Customer data in Edit
menu to enter data relevant to the plant, e.g.
project name, plant location, user.

6. If required, select Load Factory Defaults in
Edit menu if you want to load default settings
onto the user interface.
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7.4 Reading the operating status

The current operating status is indicated on the right-hand
side of the infobar.

The Diagnostics folder contains more details on errors (see
section 7.8).

7.5 Changing the user level

Note: The user level can only be changed in offline mode.

1. Select User Level in Device menu.

2. Select “Specialist” from drop-down list.

3. Enter password. This password is “samson“ in the
delivered state.

Click Modify Password button to open the window
where you can change the password.
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Properties of data points are indicated by icons when clicking on a folder:

Icon Meaning

Data cannot be changed

Data can be changed

Data point can be executed

Data point is user-defined

Mark to indicate status/error

Value has exceeded maximum limit

Value has fallen below minimum limit

Source of data:

Value has been modified manually

Value has been uploaded from the device.
In online mode, x in the icon indicates a value has been updated.

Value originates from a saved file

Value adopted from memory pen

EB 5757 EN 27

Setting and operation with TROVIS-VIEW



7.6 Configuration

Note: Section 6 contains descriptions on the functions and parameters.

1. Click Configuration folder.
The individual functions appear together with their current settings (I/O).

2. Change settings:

Double-click the required function
setting to change the function
value (I/O).
Right-click the required function to
open pop-up window to modify
function settings.

[Modify] Opens pop-up window to modify function block setting.

[Read] Uploads the function block setting from the device.
Display only in offline mode (see section 8.1.1).

[Write] Downloads the function block setting to the device.
Display only in offline mode (see section 8.1.1).

[Default: ...] Resets function to default setting (setting in gray to indicate that the
status of function is the same as the default setting)
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7.6.1 Parameter settings

1. Click Parameters folder.
The parameters appear together with their current settings.

2. Change settings:
Double-click the required parameter to open
pop-up window to modify parameter set-
tings.

Right-click the required parameter to open
pop-up window to modify parameter set-
tings:

[Modify] Opens pop-up window to modify parameter settings.

[Read] Uploads the parameter value from the device.
Display only in offline mode (see section 8.1.1).

[Write] Downloads the parameter value onto the device.
Display only in offline mode (see section 8.1.1).

[Default: ...] Resets function to default setting (setting in gray to indicate that the
status of function is the same as the default setting).

[Min ...] Set parameter to the displayed minimum value (value in gray to indi-
cate that the parameter value is the same as the minimum value).

[Max...] Set parameter to the displayed maximum value (value in gray to in-
dicate that the parameter value is the same as the maximum value).

EB 5757 EN 29

Setting and operation with TROVIS-VIEW



7.7 Operating values

Note: The values in Operating values folder cannot be changed.

In online mode (animated ) icon) the current operating values are displayed.

• Firmware version 1.0x and 2.0x

• Firmware version 2.1x

Note: The user level is set to “Customer” by default in TROVIS-VIEW. The current user level is
displayed on the status bar. When the user level is set to “Specialist”, additional information
on the stem position (retracted/extended/calculated stem position), switching output and the
device inside temperature are displayed.
Change the user level to “Specialist” by selecting User Level in Device menu (see section 7.5).
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7.8 Diagnostics

The Diagnostics folder is subdivided into the areas Information, Errors, Manual level, Status
messages and Statistics.

Information

Errors

Note: The state Malfunction, the exceptional errors Canceled while retracting stem and Can-
celed while extending stem as well as the EEPROM errors Diagnostic data: status messages
and Diagnostic data: statistics are only displayed in devices with firmware 2.00 and higher.
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Manual level

The device can be transferred to the manual level in TROVIS-VIEW when the manual level is
enabled in online mode (Enable manual level parameter = On ( icon)).

When the device is in the manual level, the actuator stem can be moved by using the
handwheel (2, Fig. 2).

The following additional actions can be performed in the manual level (firmware version
2.00 and higher):

� Retract actuator stem
� Extend actuator stem
� Move stem to normalized positioning value

The positioning value based on the input variable range (normalized positioning value)
must be entered beforehand

� LED for operation (yellow) = ON
� LED for error indication (red) = ON

The device exits the manual mode as soon as the manual level is disabled or online mode is
deactivated in TROVIS-VIEW.
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Status messages

Note: Only the status of the device is indicated in devices with firmware version 1.0x.
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Statistics

Note:
– The Statistics level is only available for devices with firmware version 2.00 and higher.
– The number of switching operations performed by the binary input and the switching

output is only logged in devices with firmware version 2.10 and higher.
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7.8.1 Additional diagnostics in Specialist user level

The default user level in TROVIS-VIEW is “Customer”. The current user level is displayed in
the status bar. When the user level is switched to “Specialist”, the Test and Calibration
subfolders appear in the Diagnostics folder.

Select User Level in Device menu to change to the Specialist user level (see section 7.5).

Test

Note: Zero calibration is not possible in devices with firmware version 1.0x.

Calibration

Note: The calibration for both inputs is performed at the zero point and final point in devices
with firmware version 1.0x.
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7.9 Operational data graphs (Trend Viewer)

The Trend Viewer is only displayed when the Trend Viewer is
checked [�] in View menu (see section 7.3).

All data of the activated list of parameters are uploaded cyclically from the device in online
mode when the Trend Viewer is activated.

The graph reading can be adapted. The input and/or the travel of the actuator can be dis-
played if their parameter box is checked.
Besides being able to select the data points, you can shift the x axis and y axis and adapt the
scale by moving the crosshair cursor over the graph (reading of changed axis values ap-
pear). You can also zoom in and out of the graph.

Click button to list plotted data points in a table and click button to export the data as
a CSV, XML or XLS file. CSV files are text files which can be edited in a text editor, Excel etc.
The data points are written in a file in rows separated by a comma.

Performing settings

You can add new data points by dragging and dropping them onto the Trend Viewer win-
dow. You can do this by left-clicking on the required data point in the folder. Keep the mouse
key pressed down and drag the mouse cursor into the Trend Viewer. You can add a new
data point in an existing or a new graph, depending on how the data point is arranged on
screen. If required, you can adapt the graph properties by double-clicking or right-clicking
(context-sensitive menu) the data point name, range of values, time axis or color. Check or
uncheck the data point checkboxes to activate or deactivate individual data points or the
whole graph.
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Select Online in Device menu to establish communication and display the selected data
points in the Trend Viewer according to the settings previously made.

Apart from merely displaying and exporting the logged data, it is also possible to save the
logged data points cyclically in a file. Right-click on the graph and select Save logging auto-
matically from the context-sensitive menu to choose a location where the logging should be
saved. Select Modify storage address for logging from the context-sensitive menu to change
this storage location. The logging is automatically saved every five minutes after the online
mode is started in a file named using the date, time and module type with the .”log” affix
(e.g. Date–Time–Module type.log) as well as when exiting the online mode. This file can be
edited as required.

Select online help for more information.
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8 Data transmission

The TROVIS-VIEW Software installed on
your computer allows you to configure the
device either in offline mode (device not
connected to a computer) or in online mode
(device connected to a computer). To acti-
vate the online mode, click on the device
toolbar. The communication port must be set
(see section 8.1)

Online mode (direct data transmission)
The device and TROVIS-VIEW are con-
nected constantly in online operation. Cur-
rent configuration and operating data are
uploaded from the device cyclically and dis-
played in TROVIS-VIEW. The settings con-
figured in TROVIS-VIEW can be directly
transferred to the device To enable commu-
nication with the PC, connect the serial inter-
face (COM port) to the serial interface
(RJ-12 jack) of the device using a SAMSON
connecting cable.
In case the computer does not have a COM
port, a USB/RS-232 adapter can be used.

Offline mode (indirect data transmission)
There is no constant data communication
between the computer and device.
Communication must first be established to
upload from the device or download data to
the device.
Data can be transferred at the serial inter-
face using the SAMSON connecting cable
or using a memory pen together with modu-
lar adapter.
A memory pen allows you to simply copy
data onto other devices.
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NOTICE
You can only transfer data to the device after the electrical connection has been performed
as described in section 4.

8.1 Data transmission between TROVIS-VIEW and the device
(connecting cable)

1. Connect the serial port of the computer using
the SAMSON connecting cable to the serial
interface connection of the actuator.

2. Select Communications in Options menu to
open the server settings window. Click Server
settings button.

3. Check Local connection and Automatically
local connect boxes and click on OK button to
confirm server settings.

The Communication window reappears.

4. Click Port settings button.

5. The settings window opens and State: not yet
searched appears in the Automatic detection
field. Click on Start button.
TROVIS-VIEW has found the device when
State: Device found on COM .... appears,
click on OK button twice to confirm settings.
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8.1.1 Offline operation (indirect data transmission)

In offline mode, there is no constant data communication between the computer and device.
Communication must first be established to upload data from the device and download data
to the device.

Downloading data to the device:
Select Download to the device in Device menu to transfer data to the device.
The control task is implemented after data are downloaded from TROVIS-VIEW.

Uploading data from the device:
Select Upload from device in Device menu to transfer all the data from the device.
Uploaded data are indicated in TROVIS-VIEW by the icon.

Note: Data transmission can also be performed by clicking the icons in the device toolbar:
click to download data from TROVIS-VIEW to the device and click to upload data from
the device and to display them in TROVIS-VIEW.

8.1.2 Online operation (direct data transmission)

The device and TROVIS-VIEW are constantly connected in online operation. Current configu-
ration and operating data are uploaded from the device cyclically and displayed in
TROVIS-VIEW. Likewise, any settings performed in TROVIS-VIEW are directly transferred to
the device.

Activate online operation:
Select Online in Device menu to activate online mode.
In online mode, on the toolbar is animated.

Deactivate online operation:
Select Online in Device menu while the online mode is activated.
The online mode is canceled.

Note: Alternatively, click on the toolbar to activate and click to deactivate online ope-
ration.
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8.2 SAMSON memory pen

The SAMSON memory pen serves as a data carrier and is able to load and save data in its
non-volatile memory.

The memory pen can be loaded with data configured in TROVIS-VIEW and the settings
transferred to one or several device of the same type and version. In the same way, the mem-
ory pen can be used to upload data from the device allowing you to simply copy the configu-
ration data from one device to another device of the same type and version.

Operating data can also be recorded with the data logging function (see section 8.2.5).

On inserting a memory pen that is empty or that contains data from another type of device
or another version of the same device into the serial interface port of the actuator, the data
from the actuator are uploaded to the memory pen regardless of the status of the memory
pen and any other data on the memory pen will be overwritten.

Note: Actions and errors of the memory pen are indicated by the yellow LED. Refer to sec-
tion 2.3.

8.2.1 Data transmission between TROVIS-VIEW and memory pen

1. Plug memory pen (3) together with modular adapter (2) into the serial interface (COM
port) of the computer (1) (Fig. 9).

2. Select Interface in Memory Pen menu.
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3. Click Start button in Automatic detection field of the dialog box.
The computer automatically searches for the interface assigned to the memory pen.

4. Message: “Memory pen found at COM …“
Confirm interface setting by clicking OK button.

Downloading data from TROVIS-VIEW to
the memory pen

5. Select Download to Memory pen in
Memory pen menu.

6. Click OK button to start data
transmission.

7. Click OK button to confirm the message
“Checking procedure completed. All
data of device will be overwritten!”

Uploading data from memory pen to TROVIS-VIEW

5. Select Upload from Memory pen in Memory pen menu to start data transmission.

8.2.2 Data transmission between the actuator and memory pen

1. Plug memory pen (3) together with modular adapter (2) into the serial interface (COM
port) of the computer (1) (Fig. 9).
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Uploading data from the actuator to mem-
ory pen

2. Select Modify memory pen status in
Memory pen menu.
Check Automatically write to memory
pen in the dialog box.
Click OK button to confirm.

3. Remove memory pen from computer and
plug it into the serial interface of the ac-
tuator (Fig. 10).
The yellow LED on the ac-
tuator indicates that data
transmission is in progress.
Data transmission is com-
pleted when the yellow
LED is illuminated continu-
ously. Remove the memory
pen from the actuator.

Downloading data from the memory pen
to the actuator

2. Select Modify memory pen status in
Memory pen menu.
Check Automatically read from memory
pen in the dialog box.
Click OK button to confirm.

3. Remove memory pen from computer and
plug it into the serial interface of the ac-
tuator (see Fig. 10).
The yellow LED on the actuator indi-
cates that data transmission is in
progress.
Data transmission is completed
when the yellow LED is illuminated
continuously. Remove the memory
pen from the actuator.
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Note: For devices with firmware version 2.00 and higher, data can be logged either
time-controlled or event-triggered. To select one of these data logging options, check the op-
tion Data logging, time-controlled or Data logging, event-controlled.

8.2.3 Copy function

The memory pen can be used to copy setting data to other Type 5757-3 Electric Actuator
with Process Controller as soon as the data from the device have been transferred to the
memory pen.

Note: “Automatically write to memory pen” is reset after the first time data are transferred
from the device.

8.2.4 Command mode

Note: The command mode can be configured in devices with firmware version 2.00 and
higher.

The memory pen is configured to be a command pen in TROVIS-VIEW. The command pen
allows the user to move the valve to the open and closed position.

While the actuator is in control operation, the memory pen can be used to transfer the device
to the command mode.

Create command pen using TROVIS-VIEW

Note: The extending and retracting of the actuator stem using the command pen is given ab-
solute priority. The actuator does not follow the input signal in this case.

1. Plug memory pen (3) together with modular adapter (2) into the serial interface (COM
port) of the computer (1) (Fig. 9).
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2. Select Set command mode in Memory
pen menu.

3. Set required action (Stem retracts or
Stem extends).

4. Click OK button.

5. Remove memory pen from computer and
plug it into the serial interface of the actu-
ator (Fig. 10).
The actuator stem is extended or retracted depending on the setting selected.

6. After removing the memory pen from the actuator, the device returns to normal control
operation.

8.2.5 Data logging

Note: The data logging function is only possible for devices with firmware version 2.00 and
higher.

The memory pen – 64 allows the following data to be saved:

� Pt 1000 input
� Flow rate
� Current input
� Stem position
� Positioning value
� Disturbance variable Z
� P component
� I component
� D component
� Malfunction
� DHW tapping
� Control
� Heat exchanger maintained at constant heat
� Frost protection
� Switching output
� Limit switch, stem retracted
� Limit switch, stem extended
� Adaptation active
� Adaptation A1 run
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� Adaptation changed
� Manual potentiometer
� Temperature inside the device

The data are logged until the memory capacity of the memory pen is full.

You can save the data on the memory pen in a file (*.log) using TROVIS-VIEW.

Data logging

1. Connect the memory pen to the serial interface of the device (Fig. 10).

The yellow LED on the device indicates that data logging is being prepared:

As soon the blinking pattern of the yellow LED changes, data transmission to the memory
pen is completed.

2. Data logging is completed when you remove the memory pen from the serial interface of
the device.

Note: You can load a data logging file in the Trend Viewer by selecting Load a graph in the
context-sensitive menu.
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Transfer logged data onto a computer

1. Plug the memory pen (3) together with
the modular adapter (2) into the serial
interface (COM port) of the computer (1)
(Fig. 9).

2. Select Upload logged data in Memory
pen menu.

3. Choose target directory.
If the target directory is not changed,
data will be saved in the directory
SAMSON > Type 5757.

4. Enter a file name.

5. Click Save button to start data transmission.
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9 Configuration list and customer data

Configuration Default setting Setting range Customer
data

Firmware version 1.0x/2.0x/2.1x

F 01 –
DHW tapping recognition

I – Flow sensor active 0
I

– Continuous control
– Flow sensor active

F 02 –
Flow sensor

I – Flow rate sensor 0
I

– Flow switch
– Flow rate sensor

F 03 –
Adaptation

I – Active 0
I

– Passive
– Active

F 04 –
Operating direction

0 – Increasing/increasing 0
I

– Increasing/increasing
– Increasing/decreasing

F 05 –
Current input

0 – Passive 0
I

– Passive
– Active

F 06 –
Function of current input

0 – Actual value 0
I

– Actual value
– Set point

F 07 –
Measuring range of current
input

0 – 0 to 20 mA 0
I

– 0 to 20 mA
– 4 to 20 mA

F 08 –
Function of binary input

0 – End maintain
temperature

0
I

– End maintain temp.
– Switchover set points

F 09 –
Maintaining exchanger at
constant heat

0 – Time adjustable 0
I

– Time adjustable
– Continuous

F 10 –
Upper limit value GWH

0 – No limitation 0
I

– No limitation
– GWH sets Y to 0 %

F 11 –
Lower limit value GWL

0 – No frost protection 0
I

– No frost protection
– GWL starts frost

protection

Firmware version 2.0x

F 13 –
Function of switching output

0 – Pump control 0
I

– Pump control
– Fault indication

F 14 –
Pump control

0 – Circulation
(DHW circuit)

0
I

– Circul. pump (DHW)
– Circulation pump

(heating circuit)
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Configuration Default setting Setting range Customer
data

F 15 –
Switching output

0 – Passive 0
I

– Passive
– Active

Firmware version 2.1x

F 16 –
Function of
switching output

1 – Passive 1
2
3

4

5

– Passive
– Fault indication
– Circulation pump

(DHW circuit)
– Circulation pump

(heating circuit)
– Tapping

Parameter Default setting Setting range
Customer

data

P 01 – Set point W1 60.0 °C 0.0 to 100.0 °C

P 02 – Set point W2 70.0 °C 0.0 to 100.0 °C

P 03 – Lower measuring range value Xmin 0.0 °C –50.0 to 90.0 °C

P 04 – Upper measuring range value Xmax 100.0 °C 10.0 to 150.0 °C

P 05 – Upper limit value GWH 95.0 °C 0.0 to 100.0 °C

P 06 – Lower limit value GWL 5.0 °C 0.0 to 20.0 °C

P 07 – Proportional gain Kp 0.8 0.1 to 50.0

P 08 – Reset time Tn 15 s 0 to 999 s

P 09 – Derivative-action time Tv 0 s 0 to 999 s

P 10 – Actuator transit time Ty 25 s 10 to 240 s

P 11 – Set-back difference 8 K 0 to 30 K

P 12 – Heating period for heat exchanger 24 h 0 to 48 h
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